
Kurzweil 3000 
Administration for 
Teachers

Notes: 
• This document is excerpted from the Kurzweil 3000 for Windows 

User’s Guide Version 10, where it appears as Appendix H.

• Cross-references that appear in blue are active links. All other 
cross-references are inoperative, but refer to accurate locations in 
other chapters of the Kurzweil 3000 for Windows User’s Guide 
Version 10.

User account administration topics.
• About User Startup Options on page 2.
• Understanding User Accounts on page 3.
• Preference Files Locations on page 4.
• User Administration with Kurzweil 3000 Standalone on page 6.
• User Administration with Kurzweil 3000 Network on page 8.

Student reporting topics.
• Working with the Usage Log on page 11.
• The Usage Log Dialog Box on page 12.

Reporting features available only with Kurzweil 3000 Network edition.
• Administering the Activity Database on page 15.
• Creating Database Reports and Form Letters on page 19.
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About User Startup Options
About User Startup Options
How users log on to Kurzweil 3000 and the default location for storing users’ 
working documents is controlled by the Ask for User at Startup option on 
Kurzweil 3000 Standalone, or the Ask for Kurzweil 3000 User Name option 
on Kurzweil 3000 Network.

For Kurzweil 3000 Standalone, you set the Ask for User at Startup option 
in the General pane of the Kurzweil 3000 Options dialog box. 

For Kurzweil 3000 Network, you set the Ask for Kurzweil 3000 User Name 
option in the Options dialog box in the Kurzweil 3000 Administrator.

Important Note: Whichever way you decide to set the option, you should do 
it when you first install Kurzweil 3000, because changing it afterwards can 
cause confusion as to where user files are stored.

If the option is selected/enabled, Kurzweil 3000 displays the User Name box 
in the Welcome window at startup. 

You can enter a new User Name, or select an existing User Name from the 
User Name box. When you enter a new name, Kurzweil 3000 creates an 
account using the name you type.

If the option is deselected/disabled, Kurzweil 3000 uses the current Windows 
user account information to create the Kurzweil 3000 user account.
Notes: 
• Windows 2000 or Windows XP Restricted users cannot change the Ask 

for Users on Startup option. 

• For more information about the Ask for Users on Startup option, refer to 
the Kurzweil 3000 for Windows Standalone Installation and 
Administration Guide. 

• For more information about the Ask for Kurzweil 3000 User Name 
option, refer to the Kurzweil 3000 for Windows Network Installation and 
Administration Guide.
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Understanding User Accounts
A Kurzweil 3000 user account consists of all the documents belonging to a 
user together with the user’s personal Kurzweil 3000 preference files. When 
Kurzweil 3000 adds a new user, it creates two folders: one for the user’s 
documents, and one for the user’s preference files. Depending on the startup 
option setting, the documents and preference files are stored in different 
locations.

Default Save Locations for Users Documents
The following locations represent the default location that Kurzweil 3000 
uses to store a user’s documents. Users may, of course, store their 
documents anywhere on the local computer, or in another place on the 
network, if available.

Depending on the startup option setting, the folder locations are as follows:

When Ask for User at Startup is deselected on Kurzweil 3000 Standalone 
or Ask for Kurzweil 3000 User Name is deselected on Kurzweil 3000 
Network, the default save location for a user’s documents is:

C:\Documents and Settings\Windows account name\My Documents 
\KESI\Kurzweil 3000
When Ask for User at Startup is selected on Kurzweil 3000 Standalone or  
Ask for Kurzweil 3000 User Name is selected on Kurzweil 3000 Network, 
the default save location for a user's documents is:

C:\Documents and Settings\Windows account name\My Documents 
\KESI\Kurzweil 3000\user_name1, user_name2, user_name3, etc.

Where user_name1, user_name2, user_name3 are folders with the names 
of individual users.
Note: User files for older versions of Kurzweil 3000 may be in:

C:\My Documents\Kurzweil Educational Systems\Kurzweil 
3000\username
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Preference Files Locations
Preference Files Locations
User preference files include the Kurzweil 3000 settings file   
K3000Settings.k3s as well as files for Vocabulary Lists, the Word Prediction 
Dictionary, and the Personal Spelling Dictionary. 

The K3000Settings.k3s file includes the settings for each of the options in 
the Kurzweil 3000 Options panes. When you make a change to any of these 
options—for example reading speed or reading highlight colors—Kurzweil 
3000 updates the settings file to reflect your changes.

Kurzweil 3000 Standalone
All preference files are stored in:

On Windows 98 and 2000:
C:\Program Files\Kurzweil Educational Systems\Kurzweil 3000\Settings

On Windows XP:

The location of the files depends on whether the Ask for User at Startup 
option is selected. 

When the option is deselected (the default), the files are in:
C:\Documents and Settings\Windows account name\Application 
Data\KESI\Kurzweil 3000

When the option selected, the files are in:
C:\Documents and Settings\Windows account name\Application 
Data\KESI\Kurzweil 3000\user_name1, user_name2,user_name3, etc.

Where user_name1, user_name2, user_name3 are folders with the names 
of individual users.
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Kurzweil 3000 Network
User preferences files are stored on the PC running the Kurzweil 3000 
Network Engine.

The files reside in:
C:\Documents and Settings\All Users\Application Data\KESI\Kurzweil 
3000 Server\Users\user_name1, user_name2, user_name3, etc.

Where user_name1, user_name2, user_name3 are folders with the names 
of individual users.

Important Note: With Kurzweil 3000 Network, only the K3000Settings.k3s 
preference file is stored on the computer running the Kurzweil 3000 Network 
Engine. Other preference files, such as Vocabulary Lists and a user’s 
personal spelling dictionary, are stored on the Client computer.

When the Ask for Kurzweil 3000 User Name option is not selected in the 
Kurzweil 3000 Administrator Network Options dialog box, the files reside in:
C:\Documents and Settings\Windows account name\Application Data\ 
KESI\Kurzweil 3000

When the Ask for Kurzweil 3000 User Name option is selected in the 
Kurzweil 3000 Administrator Network Options dialog box, the files reside in:

C:\Documents and Settings\Windows account  name\Application Data\ KESI\ 
Kurzweil 3000\user_name1, user_name2,user_name3, etc. 

For more information about administering Kurzweil 3000 Networks, see the 
Online Help available from the Kurzweil Network Administrator application, 
or see the Kurzweil 3000 for Windows Network Installation and  
Administration Guide.
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User Administration with Kurzweil 3000 Standalone
User Administration with Kurzweil 3000 
Standalone

Use the following procedures to maintain Kurzweil 3000 user accounts.

Adding New Users
You can manually add new users at startup if the Ask for Users at Startup 
option is enabled. If this option is enabled, Kurzweil 3000 displays the 
Welcome/Login window. Otherwise, Kurzweil 3000 automatically creates 
new users based on their Windows user account. 

To add a new user:
1. Double-click the Kurzweil 3000 icon on the desktop to start Kurzweil 

3000.

2. In the Welcome window, type the user’s name in the User Name box, 
then click Yes to confirm.

Changing to a Different User
You can switch to another user without having to quit and restart Kurzweil 
3000.

To switch to another user without restarting Kurzweil 3000:
1. On the File menu, click Change User to display the Change User Name 

dialog box.

2. Type the new user name in the User Name text box.

or

Click the User Name arrow and select a user name from the list.

3. Click OK to effect the change, or click Cancel to keep the original user.
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Deleting User Files

To delete a user’s files:
1. Navigate to the location where Kurzweil 3000 stores the user’s files.

The location of the files depends on the user startup option setting. See 
About User Startup Options on page 2 of the Kurzweil 3000 for Windows 
User’s Guide.

2. Click the first file you want to delete. Hold down the CTRL key, and then 
click any other files you want to delete.

A dialog box appears asking if you are sure you want to remove the 
items.

3. Click Yes.

Deleting User Accounts

To delete a user account and all the user’s files:
1. Navigate to the location where Kurzweil 3000 stores the user’s files.

The location of the files depends on the user startup option setting. See 
About User Startup Options on page 2 of the Kurzweil 3000 for Windows 
User’s Guide. 

2. Delete the folder with the name of the user you want to remove.

3. Navigate to the location where Kurzweil 3000 stores the user’s files. See 
Preference Files Locations on page 4.

4. Delete the preference files for the user you are removing.

Notes: 
• If you want to save some of the files from a user account you are deleting, 

first move the files to a different location.

• If you are on a Kurzweil 3000 Network, consult the Kurzweil 3000 for 
Windows Network Installation and Administration Guide.
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User Administration with Kurzweil 3000 Network
User Administration with Kurzweil 3000 
Network

Most administration tasks, such as adding and deleting users, are covered in 
detail in the Kurzweil 3000 for Windows Network Installation and 
Administration Guide. This section provides a brief overview of a Kurzweil 
3000 Network and information on the Kurzweil 3000 License-to-Go™ 
feature, as well as information on how to return licenses to the Kurzweil 3000 
Network Engine.

Kurzweil 3000 Network Overview
The Kurzweil 3000 Network consists of one or more (usually many more) 
computers running Kurzweil 3000 Client software and a smaller number of 
computers running the Kurzweil 3000 Network Engine software. The Client 
computers access the computer(s) running the Network Engine software 
over a TCP/IP network.

If you are on a Kurzweil 3000 Network, there will be no difference in the 
interface or functionality of Kurzweil 3000. The only difference is that your 
user preferences are stored on the Kurzweil 3000 Network Engine, and they 
are available to you regardless of which Kurzweil Network Client computer 
you are logged on to. See Understanding User Accounts on page 3.

About Kurzweil 3000 License-to-Go
The Kurzweil 3000 License-to-Go feature allows students to use Kurzweil 
3000 Client software without having to be connected to the Network. 

A License-to-Go may be issued using the following methods:

Granting a License-to-Go. Use this method to transfer a license from the 
Kurzweil 3000 Server to a Kurzweil 3000 Client computer that is connected 
to the Kurzweil 3000 Network. After you grant the license, the Client can then 
be disconnected from the Network and used outside of the Network.
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This method is useful for students with laptops who need to use Kurzweil 
3000 both in school and at home. It also allows students to use Kurzweil 3000 
in areas of the school that do not have access to the Kurzweil 3000 Network.

Generating a Remote License-to-Go Code. Use this method to create a 
Remote License-to-Go Code which a student can use to activate Kurzweil 
3000 Client software installed on a computer that is not connected to a 
Kurzweil 3000 Network.

This method is useful for students who need to use Kurzweil 3000 on a home 
computer that cannot be transported to school.

Both granted and generated licenses are valid for a specified period of time. 
When the time expires, the license automatically becomes available again on 
the Server and unavailable to the user to whom the license was transferred.

Returning Granted Licenses to the Network Engine
If you are using the Network version of Kurzweil 3000, you may have been 
issued a license using the License-to-Go license granting feature.

There might be a time when your System Administrator will ask you to return 
your License-to-Go before it is due to expire.

To return a granted license to the Network Engine:
1. Connect the computer on which the granted license resides back to your 

Network. 

2. Launch Kurzweil 3000.

3. From the File menu, choose Check In License-to-Go.

Returning a Remote License-to-Go to the Network Engine
If you are using the Network version of Kurzweil 3000, you may have been 
issued a license using the Remote License-to-Go option.

There might be a time when your System Administrator will ask you to return 
your License-to-Go before it is due to expire.
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User Administration with Kurzweil 3000 Network
To generate a Remote License-to-Go Return Code:
1. Start Kurzweil 3000.

2. From the File menu, choose Check In License-to-Go.

A dialog box appears, prompting you to confirm that you want to check in 
the license.

3. Click Yes to continue.

Another dialog box appears, informing you that there is no Kurzweil 3000 
Network Engine available and asking if you want to generate a Return 
Code.

4. If you are sure you want to continue, click Yes. Once you click Yes, your 
copy of Kurzweil 3000 will be deactivated.

Kurzweil 3000 generates a return code and displays it to you.

5. Contact your System Administrator and supply him or her with the 
Return Code.
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Working with the Usage Log
There may be times when it is important to track and monitor students’ 
Kurzweil 3000 usage. You may want to ensure that a student is using the 
appropriate tool for a task. You may want to see how long it took a student to 
perform a task. Running a log periodically, say once at the start of a semester 
and again mid-term, enables you to note progress and spot problem areas.

The Usage Log feature provides data you can use to adjust your curriculum 
or learning plans for your students as their learning abilities evolve.

There are two different logs that you can view: Word Help Log and 
Complete Log.

The Word Help Log keeps track of the following events, along with the date 
that each event occurred:

• Read single word (double-click reading). See Reading One Word at a 
Time (Double-Click Reading) on page 53 of the Kurzweil 3000 for 
Windows User’s Guide.

• Definition lookup.

• Spell word.

• Syllable usage.

• Picture dictionary lookup.

The Complete Log keeps track of the following events, along with the date 
and time that each event occurred:

• User login/logout.

• Usage Log enabled/disabled.

• File-related tasks such as open/close, creating new file, saving and 
saving as.

• Start/Stop Reading.

• Definition and Synonym usage.

• Spell Check and spelling error correction.

• Read single word (double-click reading).
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Working with the Usage Log
• Highlighting on/off.

• Vocabulary word-related tasks such as highlighting, searching and 
replacing words.

• Word Prediction-related tasks such as turning Word Prediction on/off, 
inserting words from Word Prediction and/or Vocabulary Lists.

• Picture Dictionary lookup.

By default, the Usage Log is disabled. You must enable it for each user 
separately. 

The resulting report is a viewable, read-only RTF document.
Note: The Kurzweil 3000 Network edition has additional, more advanced, 
logging features. See Administering the Activity Database on page 15 and 
Creating Database Reports and Form Letters on page 19.

The Usage Log Dialog Box
All commands and options for the Usage Log feature are in the Usage dialog 
box.

To enable the Usage Log for a user:
1. In the user’s Kurzweil 3000 window, open the Tools menu, and choose 

Usage.

2. In the Usage dialog box, click the Enable Logging box.
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3. You can limit the number of days you want the log to track. Click in the 
Save Days box and type a number between 1 and 99 inclusive. The 
default is 5.

If you want a continuous log with no limit, click the Limit log size box to 
disable limiting.

4. Click OK.

To view a usage log:
In the Usage dialog box, click View Word Help Log. The following is a 
sample of a portion of a Word Help log page.
Kurzweil 3000 for Windows User’s Guide (excerpt) 13



Working with the Usage Log
In the Usage dialog box, click View Complete Log. The following is a 
sample of a portion of a Complete log page.
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About the Following Sections 
The information in the following sections details features and functions that 
are available only with the Kurzweil 3000 Network edition and can only be 
accomplished using the Kurzweil 3000 Administrator application, which is 
located on the Kurzweil 3000 Server computer. 

This information is provided here for you, the teacher, so that you are aware 
of these important tools. If you do not have access to the Kurzweil 3000 
Administrator, you will have to work with your Network or System 
Administrator in order to make use of these tools.

For complete details about the Kurzweil 3000 Administrator, refer to the 
Kurzweil 3000 for Windows Network Installation and Administration Guide.

Administering the Activity Database
You can configure the Kurzweil 3000 Server to keep a record of students’ 
activities as they work. The Server can record such actions as looking up 
definitions, synonyms or syllables running a Spell Check or changing the 
reading speed.

Using the Server Administrator, you can perform the following database 
administration tasks:

• Update the database.

• Clean up the database.

After you have collected user activity data, you use it to generate reports and 
letters that incorporate selected data, similar to a mail merge. See Creating 
Database Reports and Form Letters on page 19.

Setting Up Activity Logging
By default, the Server does not log user activity; you must turn on this 
function. Be aware that activity logging can require large amounts of disk 
space since the activity of all users is recorded. Therefore, you need to 
ensure that there is adequate free disk space available on the Kurzweil 3000 
Server machine. It is not possible to provide specific disk space requirements 
because of the variability of individual Kurzweil 3000 Network installations. 
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Administering the Activity Database
However, space on the order of tens of megabytes is certainly a suggested 
starting point. You will need to experiment.
Note: Statistics are not logged for users who are using Kurzweil 3000 with 
the License-to-Go license granting feature.

To enable activity logging:
1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

The Lurzweil 3000 Network Administrator window appears.

2. From the Tools menu, select Options.
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3. In the Kurzweil 3000 Network Options dialog box, select Log User 
Statistics.

4. Click OK to close the dialog box.
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Administering the Activity Database
What Activities Get Logged?
The following is list of Kurzweil 3000 activities and/or events that are logged 
in the activity database:
File opened

File saved

File closed

Page scanned

Reading started

Reading stopped

Look up definition

Look up synonyms

Look up syllables

Spell a word

Spell check a document

Word Prediction enabled

Word Prediction disabled

Word inserted from Word Prediction

Reading Speed changed

Read Mode changed

Read Unit changed

User logged in

User logged out

New Text File created

New Image File created

File "Saved As"

Definition not found

Look Up in Encarta

Synonym not found

Spell Check error replaced

Spell Check error skipped

Spell Check no suggestions for word

Spell Check report

Highlighter used on text 

Highlight words in Vocabulary List

Search for words in Vocabulary List

Word inserted from Vocabulary List
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Creating Database Reports and Form Letters
You can output the activity data you collect as either a report or as form 
letters. You generate form letters from a form letter template. Form letter 
templates consist of text that you type in manually and predefined database 
field tags that you embed inside the text. See Creating and Generating Form 
Letters from the Database on page 22.

Generating Reports
The Kurzweil 3000 Network Engine includes several predefined reports that 
you can use to chart student progress. You can generate reports for 
individual students or for all students in the database.

Also, if your school has Microsoft Access 97 or another database 
management application that is compatible with the Microsoft Jet database 
format, you can create your own customized reports. Consult your database 
software documentation for instructions.

To generate a Kurzweil 3000 report:
1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

2. From the Reports menu, choose Run Report.

Report Contents

Definition Lookups Specific words looked up.

Synonym Lookups Specific words for which synonyms were found.

Syllable Lookups Specific words broken into syllables.

Spell Check Errors Specific words misspelled.

Reading Speed by User Changes to reading speed.

Student Summary Average reading speed, number of words 
looked up.

Full Database All activity.
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Creating Database Reports and Form Letters
3. In the Select Report dialog box, choose the report you want from the 
Report menu. 

4. For a report on a single student, type the name in the User Name box. 
For a report on all students, leave the User Name box blank.

5. For a report covering a specific time period, scroll to select month and 
day, then type in the year for both Starting Date and Ending Date. For 
a report covering the entire time span in the database, leave these boxes 
blank.

6. Click OK.

7. When the report appears, click Print to send it to your printer or Exit 
Report to return to the Select Report window.

By default, the data in a report is in ascending chronological order 
(earliest to latest). To reverse the order, click the Date/Time column 
head. To resize the columns, click and drag the dividers between column 
heads.
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Below are examples of a Definitions Lookup report for one student and 
a Spell Check report for a group of students:
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Creating Database Reports and Form Letters
Creating and Generating Form Letters from the Database 
The Generate Form Letters feature gives you the ability to produce form 
letters from a form letter template that you have previously created. 

A form letter template consists of manually entered “boilerplate” text merged 
with numeric data from the activity database, viewed over a specified time 
period. The numeric data corresponds to the number of times students used 
Kurzweil 3000 features such as Definition lookup or Word Prediction, and in 
the case of Reading Speed, the average reading speed.

This feature, which is similar to a mail merge, allows you to create, for 
example, weekly parent letters that detail a student’s interactions with 
Kurzweil 3000.

To create a form letter template:
The general method for creating a letter is to type “boilerplate” text that is 
appropriate for everyone who will receive the letter, insert database field 
tags, type labels for the inserted fields and type any desired explanatory text.

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

The Network Administrator appears.

2. From the Reports menu, choose Create/Edit Form Letter Template.

The Select Form Letter Template dialog box appears.
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3. Type a name for the template in the Letter Name box and click OK.

The Network Engine creates the new form letter template, and saves the 
template’s name to the Letter Name list for future use, and the Add/Edit 
Form Letter: Template Name dialog box appears.

The Add/Edit Form Letter: Template Name dialog box provides simple 
Font, [Font] Size and [Font] Style formatting tools. The Fields button 
provides access to the Insert Field dialog box.
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Creating Database Reports and Form Letters
4. Click Fields.

The Insert Field dialog box appears. The Field Name list contains a list 
of all the interactions stored by the database.

When you choose a field name, a description of the information it 
contains appears in the Field Description area.

5. Add field labels and any other desired text.

6. Click Close.

For a sample form letter template, see the next page.
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Form letter template sample. Inserted database fields are enclosed by 
double angle brackets (<< >>), all other text is typed in manually.

Generating a Form Letter
After you have created a form letter template, you can direct the Network 
Engine to generate one or more form letters, each of which will contain the 
selected user’s individual usage information.

To generate a form letter:
1. From the Reports menu, choose Generate Letters.
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Creating Database Reports and Form Letters
The Form Letter Generator dialog box appears.

2. Choose a letter from the Letter Name menu.

3. In the Students area, choose the name of each student for whom you 
want to generate a letter. To choose multiple names, hold down the CTRL 
key and click the desired names.
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4. Specify a Starting Date and an Ending Date. This range will appear on 
the cover sheet when you print the generated letters, and, within the 
letters themselves, if they contain the <<Starting Date>> and <<Ending 
Date>> database fields.

5. Click OK.

The Form Letter Display dialog box appears. The dialog box contains a 
header, which displays the name of the form letter followed by the 
specified date range. Following the header, the form letter is reproduced, 
now with the specified data replacing the field tags, one letter for each 
student you selected. A red line indicates the end of one letter and the 
beginning of the next.

6. Click Print to print all of the letters.
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Creating Database Reports and Form Letters
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